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1. Scripting

Automation Engine

You can write Scripts (small programs) to automate the execution of certain tasks during a workflow.
Writing and using such scripts is called scripting. You need the Script Runner application to link
scripting with your Automation Engine workflows. You can automate actions from Adobe applications
(e.g. lllustrator, Photoshop, InDesign) and third party tools (e.g. Alwan) using Scripts.

Some of the instances where scripting is useful are given below:

to ensure file format integrity (standardization) for workflow inputs.
to use standardized PDF as input during the Preflight process.

to automate Adobe lllustrator, Photoshop, InDesign and InDesign Server via ExtendScript on Mac

Os and Windows.

Supported Script Types

AppleScript (on Mac OS)

ShellScript (on Mac OS)

Batch files (on Windows)

Windows Script (VBScript, JScript) (on Windows)
ExtendScript (on Mac OS and Windows)

More info on Scripting :Getting Started with Scripting

More info on Scripting in workflows:Use case: Scripting
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2. Automation Engine Script Runner

The Automation Engine(AE) Script Runner is a standalone AE server component which runs scripts
on behalf of AE. You can add customization to your workflow by adding a Run Script task. This
task will run on the Automation Engine server while the execution of the script will be done on the
Script Runner application which can be installed on Windows or Macintosh. When you launch the
workflow, the following will take place:

AE Server

Run Script

@//@ A0

E’ &

AE Script AE Script
Runner Runner

(]

@

1. The Run Script task sends a request to run the specified script.

2. The Script Runner processes the request accordingly and runs the script.
3. The Script Runner sends the results back to the server.

4. The workflow will continue with the outputs from this task.
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3. Installing Script Runner

Scripting helps to customize some steps in your work flows. You can achieve this by adding a Run
Script task to the work flow where you want customization. The Automation Engine will use Script
Runner to run scripts which are stored either locally or on a server. When you launch the workflow in
Automation Engine, the Script Runner runs the script which contains the main function incorporating
the inputs from the Run Script task, output folder and some optional script parameters from the Run
Script ticket. The workflow in Automation Engine continues with the contents of the output folder
which contains the outputs from the script. To achieve this, you need to do the following steps :

1. Download Automation Engine Script runner. You can download it via the web access to the
Automation Engine Server. Client Apps > Tools .

’ |: :-' ‘|_ P I_ ‘ _ i:_’ @ running Log in to another server

Pilot

Tools Automation Engine Diagnostics

Monitor the status and activity of the Automation Engine Server.

Automation Engine 10 Backup

Use this tool when you want to make a backup of an Automation
Engine 10 Server to duplicate its configuration on a new Automation
Engine 12 Server.

I
Automation Engine Script Runner |7|

=
2 M
El‘i I E‘i E |

Allows you to automate tasks in applications like lllustrator,
Photoshop, InDesign using scripting via the Run Script task in the
Automation Engine Pilot.

M‘I

Automation Engine ArtPro Action List Editor

Create and edit ArtPro Action List files to automate tasks in ArtPro via
the ArtPro Action Listtask in the Automation Engine Pilot.

Automation Engine RunList Editor
Create and edit RunLists to collect several files into one job folder, or
to make one final PDF out of several smaller PDFs (e.g. for
imposition).

¢ On Mac OS, open the ‘dmg’ file after downloading the Script Runner which contains the
installer package. Double-click to start the installation.
¢ On Windows, double-click the downloaded installer to start the installation.
2. Install the Script Runner by following the instructions in the Installshield Wizard/Assistant and
make sure it is running in your computer.

e On Windows, open Start > All Programs > Esko > Automation Engine Script Runner >
Preferences .

e On Mac OS, open Applications > Automation Engine Script Runner > Esko > Automation
Engine Script Runner > Script Runner Preferences .
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In the Script Runner Preferences window, you can:

¢ check if the Script Runner is actually running

e start / stop the Script Runner

e enable(disable) Start at login

¢ view and change the port the Script Runner is communicating with
¢ view and change the default folders for scripts

| Start | Script Runner is not running.
4 Start at hgin

Port: 1583
Batch File Folder: C:\Eskolbg_data_fastserverscrrunn_v100\Scripts\Batch | Brose
ExtendScript Folder: C:\Esko\bg_data_fastservenscrrunnt_vi00\Soripts|Extend: Brasns
Windiawe Seript Folder: Co\Esbaba_data_fastserserscrrunnt_v100\ScrptslWind oy |Brosoe
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4, Configuring Script Runner

You can configure your Script Runner to your Automation Engine server. This computer must have
the Script Runner running.

For more information on installing a Script Runner, refer to Getting Started with Scripting

1. Choose Tools > Configure .

2. Choose Scripts from the categories on the left. Choose File > New .

=1 Configure == X

File Edit

[F-48 AE -
-4k Automation Engine Database Host:
Create DCS Master

[++-%# Digital Press

""" 4% E-Mail Configuration

~4# External Databases

4 Fastimpose Site Preferences
4} FlexProof - Image DownlLoader

Port: | 1983

Available Scripts on EAW12DL303:

"{3 FlexRip - Approval Type # Name

g E:EXS'D'EI ExtendScript EskoAlPrint jsx

e FIE"R'D o1 ExtendScript EskolDDPrint jsx

i FIE"RfP o1 Compact ExtendSeript EskolDDSaveAsPDF jsx

e FIEXRP'CDI Sumiﬁ ExtendScript EskolDServerPrint jsx

fild FI:;:“:HP Ind"iﬂ; 4000 Serics ExtendScript EskolDServerSaveAsPDF jsx

il R_p . fgm ' = ExtendSeript EskoPSDoActionAndSaveAslPG jsx

B Flexpjp-smu &r duopi t Windows Script EskoAcroCalllSFunction.vbs

EXHIP - SCreene utpu

"{3 FlexRip - Unscreened Output

[+H-%# Jobs

-3 Nexus

3}

g Eudtm:atmn Available Scriptz on Automation Engine:

ystar

-4 Preflight Tools Type » Name

"{3 Processing Preferences Batch File XPR.bat

g Products ExtendScript EskolDDSaveAsPDF jsx

Scripts ExtendScript EskolDDSaveAsPDFbad jsx
ExtendScript E=kolDDSavessPDF_noparams.jsx
Windows Script EskoAcroCalllSFunction.vbs

| o8 Windows Script EskoAcroPrint.js

# MAPAMALC
#F Hostname_7
-4k Shuttle -

3. Give a suitable name to the Script Runner by choosing File > Rename
4. Enter the computer name or IP address of the Script Runner computer in the Host field.
5. Enter the Port used to connect this computer to your Automation Engine server.

By default, this is 1983.

6. Click the Test Connection button. If you have configured the Scrpt Runner successfully, you will
see either all the scripts available on the Script Runner or a message 'No scripts available'.
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5. Scripting for Script Runner On Mac OS.

A Script Runner on Mac OS supports AppleScript and Shell Script to automate operations.

Note:

Sample scripts are provided as-is with no warranty of fitness for a particular purpose. These scripts
are solely intended to demonstrate techniques for accomplishing common tasks. Additional script
logic and error-handling may need to be added to achieve the desired results in your specific
environment.

It is up to the user to verify that his intended use of the offered automation functionality is compliant
with any third party license agreement and/or other restrictions applicable to any non-Esko products.

5.1 Using AppleScript on Script Runner

AppleScript is a scripting language that makes direct control of scriptable applications and of many
parts of the Mac OS possible. An AppleScriptable application is one that makes its operations and
data available in response to AppleScript messages, called Apple events.

We recommend using AppleScript because:

e it is highly integrated into the Mac OS
e it is supported by a lot of third party applications
e it has a high level of accessibility for scripting beginners

1. Open the AppleScript Editor and add following code.

®00 Untitled —
— - -
Q@& N\ 5
Record Stop  Run Compile Bundle Contents
AppleScript - <Mo selected element>

on main{inputs, ocutputFolder, params)
log "Hello, World!"
return "OK"

end main

| Description | Event Log

Options Description

mai n This function will be called by the Script
Runner. Only the code in this main function
gets executed.

i nputs The first argument of the main function: a list
of input file paths (type: list of strings).
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Options Description

out put Fol der Second argument of the main function: the
folder where AE expects the script’s result files.
AE will continue the flow with the files you write
in this folder. If you leave this folder empty, AE
will continue the flow with the inputs of the Run
Script task (type: string).

par ans Third argument of the main function: additional
script parameters injected into the script via
the Run Script ticket (type: list of strings).

| og Extra log information in the Run Script task
details

return “ K’ This will communicate with the Run Script task
that everything went fine. Other possibilities
are return “Warning” and return
“Error”.

2. Save this code as an AppleScript text file in the Script Runner’s AppleScript folder (default: /
Library/Scripts/Esko/AppleScript) or in the Automation Engine AppleScript folder.

Save As: MyHelloWorld.applescript @
[« ») (82 =|m) [3JAppleScript B @
DEVICES [] ColorSync [ AppleScript .
£ Mac HD m] ] Esko » ||| £ ExtendScript
= iDisk = m || Folder Action Scripts |1 Shell
o || Folder Actions
SHARED " D Font Book Y
PLACES . ¥ [ FontSync Scripts
I ) I
I Desktop L —— L
File Format: | Text Iz ]
Line Endings: | Unix (LF) )
Options: Run Only Startup Screen
Stay Open
u Y s Y £ >}
[ New Folder | | Cancel ) Save

2

Note: Script Runner supports ‘Text’ format. Therefore it is essential to change the file format to
‘Text’.

3. You can add following code to test this script locally in the AppleScript Editor. Save the file and
click Run to execute the script.
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on main(inputs, cutputFolder, params})
log "Hello, World!"
return "OK"

end main

on run
-— Our main funetien is net using any of its
arguments, so provide empty ocnes
set inputs to {} -- empty list
set outputFolder to "" -- empty string
set params to {} -- empty list
main(inputs, outputFeolder, params)
end run

[ Description |-inn-hg-i

80O || MyHelloWorld.applescript ()

~

on main(inputs, outputFolder, params}
log "Hello, World!"
return "OK"

end main

on run
-= Qur main function is not using any of its arguments, so
provide empty ones
set inputs to {} -- empty list
set outputFolder to ™" -- empty string
set params to {} -- empty list
main(inputs, outputFolder, params}
end run

[ Events ) | Result

(*Hello, World!*)

Result:
"OK"

[ Description I-i\nn-hg-]

A

Notice the ‘Hello, World!” and ‘OK’ result in the event log. The Script Runner does not attend to
the test code in your script. It will execute the contents of the main function and ignore the rest.
Therefore, you can keep your test code for future local testing.

4. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a New
Task. Choose the Run Script task, modify its settings and launch the task.

10



Automation Engine

amn Mew Task - Default

= } | Launch Priority: | Normal '3] [ Hold

Ticket: 7@ ~ Tickets: % -

Settings for Step: Run Script

' Output in: I
File Name:
o
Runan: | My Mac Script Runner | § ]
Script Type: | AppleScript -:]
Script File: MyHelloWorld.applescript [1 L]

Script Parameters

Read more in Run Script

Note that the ‘Hello, World!" in the task details and ‘OK’ state are corresponding with | og
“Hello, World!” and‘return “OK’’ inthe script.

800 Tasks (RunScriptDemo)
= [ &= I [ RunScriptdemo o a-
Mode Job Newjob Search
v viEws Job Name File Name TaskType Progress  Prase St | Launched ] TaskiD
RunScriptDemo _ Blairon POF.pdf  Run Script. 100% R | 5/23/12 3:56 PM__ 3452
Task Type: Run Script —
- Stared o eoezingem
i pro st 123712 3:56 P
=l 12312 3:56 P
e P me: 00000
(5] Pl The andard output stream:
Heo Hello, World!
The script's error output stream
B Tasks <none>
ones

= S <

E &
Relaunch  Move to History Delete

10f 1 selected Server: begezingem User: admin (7] 0

5.1.1 Using AppleScript On Script Runner: A Sample Case

In this example, we use AppleScript to copy every input file with a size smaller than the size specified
in the script parameters to the output folder.

We can usei nput s, out put Fol der and par ans in the AppleScript to achieve our objective. First,
we demonstrate how to duplicate files without the size restriction and then proceed with the actual
case.

1. Open the AppleScript Editor and add the code given below. This code is aimed to iterate through
the list of inputs. It enables you to handle the inputs one by one, via the ‘input’ variable.

g
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000 Untitled —
Q@& N 3
Record Stop Run  Compile Bundle Contents.

AppleScript 3| <No selected element>

on main(inputs, outputFolder, params)
-- Tterate through the list of inputs
repeat with input in inputs
-- Add code here to handle each input

end repeat
return "OK"
end main
Events Replies [ Result

| Description | Event Log

A

2. You can modify the Script as given below to duplicate the files to a specified output folder
without size restrictions. Save this code as an AppleScript text file in the default AppleScript
folder of Script Runner(default: /Library/Scripts/Esko/AppleScript) or in the Automation Engine
AppleScript folder.

800 " MyDuplicate.applescript =]
Q@e N\ 3
Record Stop  Run Compile Bundle Contents
AppleScript 3| <No selected element>

on main(inputs, outputFolder, params)
-- Translate the output folder (UNIX path) into an AppleScript file reference
set outputFolderReference to POSIX file outputFolder

-- Iterate through the list of inputs

repeat with input in inputs
== Translate the input (UNIX path) into an AppleScript file reference
set inputReference to POSIX file input

== Duplicate input to output folder

tell application "Finder" to inputReferer to outputFolderReference with
replacing
end repeat
return "OK"
lend main
Events Replies [ Result ]

"oK"

| Description |-Event Log

A

3. Add the file size check in the code as given below. This will duplicate the file when the input file
size is smaller than the maximum size from the script parameters. If this condition is not met it
will add an entry in the log and there will be "Warning". Save the file.

12
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00 ~ MyDuplicate.applescript (=]

on main{inputs, outputFolder, params)
set returnValue to "OK"

-- Translate the output folder (UNIX path) into an AppleScript file reference
set outputFolderReference to POSIX file outputFolder

-- Get the maximum size from the script parameters and convert from
megabyte to bytes
set maxSize to (item 1 of params) #* 1000000

-- Iterate through the list of inputs

repeat with input in inputs
-- Translate the input (UNIX path) into an AppleScript file reference
set inputReference to POSIX file input

-- Get the size of the input
set inputSize to size of (info for inputReference)

—- Check wether the input is OK to duplicate
if inputSize < maxSize then
-- Duplicate input to output folder
tell application "Finder" to duplicate inputReference to
outputFolderReference With replacing
else
log input & " is too big to duplicate"”
set returnValue to "Warning"
end if
end repeat

return returnValue
end main

[ Drescription |—mn-hlg-]

P

4. Open the Automation Engine Pilot. Go to Files view where you can select the files to be copied
and open a New Task. Choose the Run Script task, modify its settings and launch. This modified
ticket will duplicate every selected file which is smaller than 10MB to the current job’s Script
Output folder. In this example, we excuted this task for two files(Blairon.pdf: 22MB and Dansk
Droge.pdf: <1MB).

_::EI Launch Priority: Naormal B‘ ] Held

Ticket: 5=~ Tickets: % -

Settings for Step: Run Script

Qutput in: | [lob URL]/ScriptQutput [1
File Name: e
o
Run on: | My Mac Script Runner I-ﬂ
Script Type: | AppleScript Fo
Script File: MyDuplicate.applescript [1 d

Script Parameters

13
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‘Dansk Droge.pdf’ is duplicated into the job’s Script Output folder. ‘Blairon.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state and added an entry in the task

details.
Files (RunScriptDemo)
| p
o |5 RunScriptDemo T a
| Mode Job New Job Search |
‘ VIEWS [& RunScriptDemo Name 4 View Type Size Date |
B [ Artwork Dansk Droge.pdf View  PDFFile 89KB 2/10/10 2:16 PM |
! r——
To Do List B Esko No
2] pages | SeriptOutput Favorites
8 Products
[ proofs n s 5 5
(B begezing: = 52 MyJobContainer ~ 1] RunScriptDemo = [ ScriptQOutput
[ WebCenter |
i Plates File Name Task Type Progress | Phase State  flaunched TaskID |
. - Blairon.pdf,Dansk Droge.pdf Run Script 100% (L] 5/31/12 12:36 PM 3781
T Taske 8,06 Details
= Task Type: Run Seript
=) Mileste
£ Milestones Started on Server: begezingem
L Tickets Started at 5/31/12 12:36 PM
TOOLS Finished at 5/31/12 12:36 PM

Process Time 0:00:00

7] Devices
The script's standard output stream:

[ Queue Monitor ° X i X
[Volumes/MyJobContainer/RunScriptDemojArtwork/Blairon.pdf is too big to duplicate

5 containers The script's error output stream:

g5 Customers <none>

& Users <
() Hot Folders

s Pe
_ o
New Task : NewWorkflow Info
1 file Server: begezingem User: admin (3]0 a

5.2 Using Shell Script on Script Runner

In this example, we use a Shell Script to copy every input file with a size smaller than the specified
size in the script parameters to the output folder.

1. Open a text editor and add following code. When the Script Runner executes this code, $1 (the
script’s first argument) will contain a string of input file paths separated by : . The code splits up
the concatenated file paths into a real list. This helps to iterate through the list and handle the
Run Script task’s inputs one by one.

14
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00 “ | untitled text =]
o TH @ (New Document) Iﬂ_
+  untitled text % .
]
#!/bin/bash

# Split up the input file paths into a list

# via the Internal Field Separator (IFS)
OLDIFS=3IFS # Always keep the original IFS

IFS=":" # Now set it to ":'

# Split up '$1" into the 'inputs' wvariable, with ':
inputs=( $1 )

IFS=$0LDIFS # Restore the original IFS

v

as separator

inputCount=${#inputs[@]}

# Iterate through the list of inputs
for (( i=0; i<${inputCount}; i++ )J;

do
# Add code here to handle each input
done
exit @
&) <>
201 (none) % |Unicode (UTF-8) # |Unix(LF) %] ] 443 /7220 .

2. Write and save the code as below. This script copies the input to the output folder if the input’s file
size is smaller than the maximum size from the script parameters. If the size of the file is bigger, it
adds an entry in the log and makes sure the task ends in ‘Warning’ state (via exit value ‘1’). Save
this code as a text file to the Script Runner's Shell folder (default: /Library/Scripts/Esko/Shell)
or to the Automation Engine Shell folder.

anon | MyCopy.sh
@3, 4p-, LastSaved: 19/06/12 10:04:19
‘/y |T_|”_ [ 1] ':_J File Path v : /Library/Scripts /Esko/Shell/MyCopy.sh
[ MyCopysh = = #y
-
#!/bin/bash

2l

# Split up the input file paths into a list

# via the Internal Field Separator (IFS)

OLDIFS=$IFS # Always keep the original IFS

IFS=":" # Now set it to ":'

# Split up '$1' into the 'inputs' variable, with ':' as separator
inputs=( $1 )

IFS=$0LDIFS # Restore the original IFS

inputCount=${#inputs[@]}

# Get the output folder
outputFolder=$2

# Get the maximum size from the script parameters
# and convert from megabyte to bytes
maxSize="expr $3 \* 1000000°

exitValue=0

# Iterate through the list of inputs
for (( 1=0; i<${inputCountl}; i++ ));
do
input=${inputs[$i]}
# Get the size of the input
inputSize="1s -1 "$input” | awk '{print $5}'

# Check wether the input is OK to copy
if [ $inputSize -1t $maxSize ]; then
# Copy input to output folder
cp -f "$input” "$outputFolder"
else
echo "$input is too big to duplicate"
exitValue=1
fi
done

exit $exitValue

e 4>

40 1 Unix Shell Script % | Unicode (UTF-8) % Unix (LF) * | 892 / 140/ 40 Y

15
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$1 First shell script argument: the Run Script
task’s inputs. A string of input file paths,
separated by ‘.

$2 Second shell script argument or output
folder: This is the folder where Automation
Engine expects the script’s result files. AE
will continue the flow with the files you write
in this folder. If you leave this folder empty,
AE will continue the flow with the inputs of
the Run Script task.

$3, $4, 35, ... Remaining shell script arguments:
additional script parameters which you
can inject into the script via the Run Script

ticket.
exi t Val ue Ending Status of the task
0 OK
1 Warning
2 Error

3. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a

New Task. Choose the Run Script task, modify its settings and launch. This modified ticket will
duplicate every selected file which is smaller than 10MB to the current job’s Script Output folder. In
this example, we excuted this task for two files(Blairon.pdf: 22MB and Dansk Droge.pdf: <1MB).

N0 New Task - Default

-::_JJ Launch Priority: | Normal & ] [ Ho

Ticket: - Tickets: % -

Settings for Step: Run Script

.- Output in: | [Job URL]/ScriptQutput 1
File Name:
a
Run on: | My Mac Script Runner |3 ]
Script Type: | Shell Script H4
Script File: MyCopy.sh [1 L]

Script Parameters

‘Dansk Droge.pdf’ is duplicated into the job’s Script Output folder. ‘Blairon.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state (due to exi t Val ue=1 in the
code) and added an entry in the task details.
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000 Files (RunScriptDemo)
[ = [ & W | RunScriptbemo BREC]
Mode Job Newjob
v viEws v & RunScriptDemo Name Al view | Type Size | Date
> rtwork. ) Dansk Droge.pdf View  PDFFile 89KB 2/10/10 2:16 PM
> [ Esko No
A > @ ScriptOutpist Favorites
8 products
8 begezing: ~ 2 MylobContai ]
File Name TaskType Progress | Phase Sute | Launched TaskiD
Blairon.pdf,Dansk Droge.pdf  Run Script 100% 0 5/31/1212:36 PM 3781
Detail
Task Type: Run Script
Started on Server: begezingem
3 Tickers Started 2t $/31/12 12:36 PM
v Too1s Finished at: 5/31/12 12:36 P
5 vevices Process Time: 0:00:00
17 Queue onitor | The scrpt's standard output stream:
df i too big to duplicate
C@mmis The script's error output stream:
B Customers <none>
A Users /|

(2 Hot Folders.

NewTask  NewWorkflow Info
1 file

17
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6. Scripting for Script Runner on Windows

A Script Runner on Windows supports Windows Script and Batch File. We recommend Windows
Script for its scripting abilities comparable to batch files, its wider range of supported features and
the simpler syntax. Windows Script is plain-text VBScript or JScript which is interpreted and run by
the Windows Script Host.

6.1 Using Windows Script on Script Runner

18

1. Open a text editor and add the following code:

[of *new 1- Notepad+~+ = | B )
File Edit Search VYiew Encoding Language Settings Macro Run  Plugins Window } X

PR = R =RERIEy = DiociwyglxxBE|I=1E3
= new 1 l

2

Function Main{inputs, outputFolder, params)
WScript .Echo "Hell Wo

' Set the function's return value.
Main = "
End Function

length:148 Ln:6 Col:39 Sel:0 Dos\Windows AMNST INS

Function Min The function that will be called by the Script
Runner. Script Runner executes only the
code in this main function.

i nputs First argument of main function: a list of
input file paths(type: list of strings).
out put Fol der Second argument of the main function:

the folder where AE expects the script’s
result files. AE will continue the flow with
the files you write in this folder. If you leave
this folder empty, AE will continue the flow
with the inputs of the Run Script task (type:
string).

par ans Third argument of the main function:
additional script parameters injected into
the script via the Run Script ticket (type: list
of strings).

Wbcri pt . Echo This puts some extra log info in the Run
Script task details and log. This call prints
text to the Console and adds a newline
character without Script Runner context.
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Main = “OK” This will communicate with the Run Script
task that everything went fine. Other
possibilities are Mai n = “War ni ng” and
Main = “Error”.

2. You can test this script locally by adding the following code: Save this file. Open command
pronpt. Change the directory to the script’s parent directory. Run command ‘cscript
MyHelloWorld.vbs’.

o
ot\MyHelloWorld.vbs L= B s
File Edit Search VYiew Encoding Language Settings Macro Run  Plugins Window 7} X
o =B H B QQIBJ|05'|:HD|9 |ﬁﬂbﬂ|g3|‘—'.‘l.t_!.|i*'-Lj»

& MyHelloWorld.vbs l

2
Function Main({inputs, outputFolder, params)
WScript.Echo "Hello, World!"™

6 ' Set the function's return value.
Main = "CE"
End Function

10 ' Our main function is not using any of its arguments,
11 ' 30 provide empty ones.

12 Dim inputs()

13 Dim outputFolder

14 Dim params ()

15 Main inputs, outputFolder, params

length:314 Ln:16 Cel:1 Sel:164 Dos\Windows AMSI INS

This will produce the output ‘Hello, World!’ to the console. The Script Runner does not attend to
the test code in your script. It will execute the contents of the main function and ignore the rest.
Therefore, you can keep your test code for future local testing.

3. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a New
Task. Choose the Run Script task, modify its settings and launch the task.

19
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800 Mew Task - Default

E:QI Launch EPrioriw: Normal B: ] Hold

Ticket: =~ Tickets: % -

Settings for Step: Run Script

Output in: 1
a

File Name:

Run on: | My Win Script Runner |+i

Script Type: | Windows Script |+i

Script File: MyHelloWorld.vbs [1 d

Script Parameters

Note that the ‘Hello, World!" in the task details and ‘OK’ state are corresponding with
Wscri pt. Echo “Hello, World!” and Main = “OK” in the script.
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eano Tasks (RunScriptDemo)
[ = | 28 n [ RunScriptDemo = ] [ +M ] Q-
Mode Job New Job Search
¥ VIEWS e Job Name File Name Task Type | Progress Phase | State Launched v| Task ID
) Files '] RunScriptDemo  Blairon.pdf  Run Script  100% [ | 6/6/12 11:07 AM 3865
Lol Task Type: Run Script
Started on Server: begezingem
m Pages
99 Products Started at: 6/6/12 11:07 AM
== Finished ac 6/6/12 11:07 AM
i) Proofs
Process Time: 0:00:00
WehCenter L
- The script's standard output stream:
18] Piates Microsoft (R) Windows Script Host Version 5.8
Copyright (C) Microsoft Corporation. All rights reserved.

[£] coi
=) Tasks L

h'“ Hello, World!
B The script's error output stream:
1 Tickets <none>
¥ TOOLS 5 . =
Foeics 1| 2] @ QO
= v Relaunch | Move to History Delete
= "

1 of 1 selected Server: begezingem User: admin 0

6.1.1 Using Windows Script On Script Runner: A Sample Case

In this example, we use Windows Script to copy every input file with a size smaller than the size
specified in the script parameters to the output folder.

We can use i nput s, out put Fol der and par ans in the AppleScript to achieve our objective. First,
we demonstrate how to duplicate files without the size restriction and then proceed with the actual
use case.

1. Open a text editor and add the code given below. This code is aimed to iterate through the list of
inputs. It enables you to handle the inputs one by one, via the ‘input’ variable.

R

.
Q{ *new 2 - Notepad++

- o

File Edit 5Search View Encoding Language Settings Macro Run  Plugins  Window ? X

PR = R =RERIFEY= Diocimyg|l+=x|BEIS1E3 "
B new 2]

2 Function Main({inputs, outputFolder, params)

4 ' Iterate through the list of inputs.

=] For Each input In inputs

& ' Add code here to handle sach input.

Hext

' Set the function's return value.
Main = "CKE"

TR T ]

End Function

3

I
[

4| 1 +

length:257 Ln:10 Col:16 Sel:0 Dos\Windows AMST INS

%

2. You can modify the Script as given below to duplicate the files to a specified output folder without
size restrictions. Save this code as a text file with ‘.vbs’ extension (VBScript) in the Windows
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Script folder of Script Runner (default: C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts
\WindowsScript) or in the Automation Engine WindowsScript folder.

] CaEskolbg data fa \MyCopybs - Notepad-++ (=2 |(=) e
File Edit Search Yiew Encoding Language Settings Macro Run  Plugins Window ? X
a5 = T s = >3

eI LR IR I
= MyCopy.vbs |

2 EFunction Main(inputs, outputFolder, params)

4 r ' Create the file system object that is going to do the copying.

& Dim filesys

& Set filesys = CreateObject("Scripting.FileSystemCbject™)

7 = WScript.Echo "File system ocbject created"”

g r ' Iterate through the list of inputs.

10 H For Each input In inputs

11 ' Copy input to output folder.

12 r Dim outputFile

13 ocutputFile = cutputFolder & "\" & filesys.GetFileName (input)

14 r filesys.CopyFile input, outputFilel

ks Hext

16

17 ' Set the function's return value.

18 = Main = "CHE"

14 End Function

20
4 1 | b
length: 578 lines: 20 Ln:14 Col:43 Sel:0 Dos\Windows AMNST INS

3. Add the file size check in the code as given below. This will duplicate the file when the input file
size is smaller than the maximum size from the script parameters. If this condition is not met it
will add an entry in the log and there will be "Warning". Save the file.
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[ Bl
Q{ *C:\Esko\bg_data_fastserverscrrunnt_v100hScripts\WindowsScriptiMyCopy.vbs - Notepad++ E@g
File Edit Search VYiew Encoding Language Settings Macro Run  Plugins Window 7} X

cHBB LB sdaEle oyt BE1ER EEH >
= Mﬂhpyxbsl

2 EE&nction Main(inputs, outputFolder, params)

& = Dim returnValue

4 returnValue = "OE"

i

& ' Get the maxXimum size from the script parameters

' and convert from megabyte to bytes.
Dim maxSize
maxSize = params(0) * 1000000

s o oo m

11 r ' Create the file sy=stem object that is going to do the copying.

12 Dim filesys

13 Set filesys = Create0Object("Scripting.FileSystemCbject™)
14 = WScript .Echa "File system object created"”

L)

16 r ' Iterate through the list of inputs.

17 H For Each input In inputs

' Turn the input path into a file aobject.

[T

Dim inputReference
Set inputReference = filesys.GetFile (input)

2 ' Check wether the input is CK to copy.
3 B If inputReference.Size < maxSize Then
4 ' Copy input to output folder.
5 Dim outputFile
& outputFile = outputFolder & "\" & filesys.GetFileName (input)
7 r filesy=s.CopyFile input, outputFile
g8 [H Else
g WScript.Echo input & " i= too bkig to copy"”
0 r returnValue = "Warning"

F End If

Hext

[T U =

' Set the function's return value.
Main = returnValue
End Function

w
T

WG L) W L W L L R R R R R ORI ORI R ORI R

.

4 1 | 3

length : 1046  lines : 37 Ln:31 Col:15 5el:0 Dos\Windows AMNSI NS

h

4. Open the Automation Engine Pilot. Go to Files view where you can select the files to be copied
and open a New Task. Choose the Run Script task, modify its settings and launch. This modified
ticket will duplicate every selected file which is smaller than 10MB to the current job’s Script
Output folder. In this example, we excuted this task for two files(Blairon.pdf: 22MB and Dansk
Droge.pdf: <1MB).
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Y New Task - Derault
=13 | taunch priority: [ Normal  [3] [ Hold = Ticket: £~ Tickets: & -
Settings for Step: Run Script
Output in: | [Job URL]/ScriptOutput 1
File Name: TS
a
Run on: [ My Win Script Runner I-ﬂ
Script Type: [ Windows Script l—ﬂ
Script File: MyCopy.vbs [1 d

Script Parameters

‘Dansk Droge.pdf’ is duplicated into the job’s Script Output folder. ‘Blairon.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state and added an entry in the task

details.

800 Files (RunScriptDemo)
[ == n [ RunScriptDemo :J [ +M J [ Q
¥ VIEWS v (L RunScriptDemo 2 : View | T.. Size | Date
: Dansk Droge.pdf View P... 89KB 2/10/...
B : E :rt:vork og No
. : sko -
To Do List Favorites
) Pages » [ SeriptOutput
98 products ||E| s My - RunScript_Demo | ScriptDutput|
Proofs File Name Task Type Progress Phase 2 Launched Task ID
WebCenter Blairon.pdf,D... Run Script 100% [ 6/6/12 4:2... 3866
[l Plates oNelo) Details
Ei i Task Type: Run Script -
| Started on Server: begezingem
Tasks Started at: 6/6/12 4:27 PM
Milestones Finished ac: 6/6/12 4:27 PM
077 Tickets Process Time: 0:00:00
v TOOLS | The script's standard output stream:
i | Microsoft (R) Windows Script Host Version 5.8
|E| Devices Copyright (C) Microsoft Corporation. All rights reserved.
Queue Monitor
E RIS File system object created
5‘. \\begezingem'\MyJobContainer\RunscriptDemo\Artwork\Blairon. pdf is too big to copy
[ TS The script's error output stream:
‘ <none:> 4
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6.2 Using Batch File for Scripting on Windows

In this example, we use Batch File to copy every input file with a size smaller than the size specified
in the script parameters to the output folder.

1. Open a text editor and add the code given below. This code is aimed to iterate through the list
of inputs. It enables you to handle the inputs one by one, via the command % (the script’s first
argument) will contain a string of input file paths, separated by *; °.

& *new 1- Notepads+ R — N |

File Edit Search View Encoding Language Settings Macro Run  Plugins  Window } X

sOB BB LE]| Dioe|lnyl+x|BER| 5 1BER|eEn®El
= new 1 l

1 GEecho off

2 rem First script argument contains the input file paths

2 =et inputs=%1

4 rem Trim surrounding guotes

5 for /f "usebackq tokens=*" %%a in ('$inputs%') do set inputs=%%-a

&

7 set exitValue=0

% rem Iterate through the input file paths which are separated by ;'

10 : ITERATE INPUTS

11 if "%inputsi"=—"" goto EXIT

12 for /f "tokens=1 delims=;" %%z in ("%i
12 for /f "tokens=1* delims=;" %%z in ("%inpu

14 goto ITERATE INPUTS

") do call :HENDLE INPUT "%%a™

") do set inputs=%%b

1& :HANDLE INPUT
17 echo &dd code here to handle each input

funy

goto reof

funy

:EXIT

exit %exitValue%

B o wom

[V (ST (6

Bate length: 575 lines: 22 Ln:22 Col:1 Sel:0 Des\Windows AMNST INS

%

2. You can modify the Script as given below to duplicate the files to a specified output folder
with a size check. Save this code as a text file with ‘. bat ’ extension in the Script Runner
Batch File Folder (default: C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts\BatchFile) or in
the Automation Engine BatchFile folder.
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- r—' o — —— TeE - B
[ CA\Esko\bg_data_fastserve nnt_v100\Scripts\Batch\myCopy.bat - Notepad++ r Elélg

File Edit Search VYiew Encoding Language Settings Macro Run  Plugins Window 7} X
cEHHE R hB| saD|oe ity BE(H1ER EENMEl 7
= myCopy bat |

1 Gecho off

2 rem First script argument contains the input file paths

32 set inputs=%1

4 rem Trim surrounding guotes

5 for /f "usebackq tokens=*" %%a in ('%inputs%") do set inputs=%%-~a
&

rem Get the output folder

set outputFolder=%2

Wwom ]

10 rem Get the maximum size from the script parameters
11 rem and convert from megabyte to bytes
12 set /a maxSize=%3*1000000

14 set exitValue=0

T

16 rem Iterate through the input file paths which are separated by ";
17 : ITERATE INPUTS

18 4if "%inputsi"=—"" goto EXIT

1% for /f "tokens=1 delims=;" %%z in ("%#inputs%") do call :HANDLE INPUT "%%a"
0 for ff "tokens=1* delims=;" %%a in ("%inputs%") do set inputs=%%b

1 goto ITERATE INPUTS

2

3 :HANDLE INPUT

4

rem Get the size of the input
for %%? in (%1) do set inputSize=%%-~z? "
rem Check wether the input is OE to copy

=l o,

if %inputSize% lss I%maxSize% (
rem Copy input to output folder
copy /vy %1 %outputFolder%

) else |

1 echo %1 is too big to copy
2 =et exitValue=1
2 )
4 goto :eof 1
5
:EXIT

P

exit %exitValue%®

(=51

Automation Engine

o T L2 V¥ N ¥ T Y% 1y ' T X T o Y Y T e Y 5 T o O L L
== TN < = =]

-

1

| b

Bate length:973  lines: 38

Ln:38 Col:1 Sel:0

Dos\Windows ANSI INS

9%

%2

93, %, 95...

First batch file argument: the Run Script
task’s inputs. A string of input file paths,
separated by ;.

Second batch file argument or output
folder: the folder where AE expects the
script’s result files. AE will continue the flow
with the files you write in this folder. If you
leave this folder empty, AE will continue the
flow with the inputs of the Run Script task.
Remaining batch file arguments: additional
script parameters, injected into the script
via the Run Script ticket.

26




Automation Engine

Exit val ue Ending Status of the task
0 OK

1 Warning

2 Error

3. Open the Automation Engine Pilot. Go to Files view where you can select the files to be copied
and open a New Task. Choose the Run Script task, modify its settings and launch. This modified
ticket will duplicate every selected file which is smaller than 10MB to the current job’s Script
Output folder. In this example, we excuted this task for two files(Blairon.pdf: 22MB and Dansk

Droge.pdf: <1MB).

Aano New Task - Default
= } | Launch EPriority: Normal I:] ] Hol

Settings for Step: Run Script

Ticket: 7~ Tickets: E -

Output in: | [Job URL]/ScriptOutput EROWSE [N
File Name:
£ )
Run on: | My Win Script Runner | 3 ]
Script Type: [ Batch File 4 ]
Script File: myCopy.bat [1 j

Script Parameters

‘Dansk Droge.pdf’ is duplicated into the job’s Script Output folder. ‘Blairon.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state and added an entry in the task
details.

806 Files (RunScriptDemo)
(o= W (uuscpom i o
Mode Job New Job Search

¥ VIEWS l& v (L RunScriptDemo | Name A View | .. Size | ...

"B Files » [ Artwork @Dansk Droge.... View .. 89KB .. No
» [ Esko
To Do List i
& » (] SeriptOutput Favorites
(2] Pages
24 products (= - 33 - £ RunScript = (] ScriptOutput
[ proofs File Name Task Type | Progress | Phase State Task 1D
[&] webCenter Blairon.pdf,Dansk Droge.pdf  Run Script  100%
] Plates 000 Details
Task Type: Run Seript
ol

wles)
) Tasks Started at: 6/27/12 10:44 AM
Milestones W Finished av 6/27/12 10:44 AM
7 Tickets Process Time: 0:00:00

¥ TOOLS The script's standard output stream:
@ T "\\begezingem\MyJobContainer\RunScriptDemo\Artwerk\Blairon.pdf" is too big to copy

4| 1 file(s) copied.

|12 Queue Menl... || The script's error output stream:

v
<none>
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/. Using ExtendScript on Script Runner(On
MacOS/\Windows)

28

A Script Runner supports direct interpretation of ExtendScript by the Adobe Creative Suite (CS)
application selected in the Run Script ticket.

ExtendScript is JavaScript extended for Adobe CS applications. Adobe provides a complete
integrated development environment (IDE) for programming ExtendScript which is the ExtendScript
Toolkit (ESTK). Latest versions of the ESTK are available with the Creative Suite. For more info and
Adobe scripting resources visit the Adobe Scripting Center.

1. Open the ExtendScript Toolkit and add following code. Save this code in the Script Runner’s
ExtendScript folder. The default location is : /Library/Scripts/Esko/ExtendScript for a Script
Runner on Mac OS or C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts\ExtendScript on
Windows. Alternatively, you can save them in the ExtendScript folder of Automation Engine.

%) * Spurcel
5.3 | Acobe llustrator GS5.1 ) [ 3 B U EH > Y A v;
1 function main (inputs, outputFolder, params)
g T $.writeln ("Hello, World!");
4 alert {"Another vay to say: Hello, Warld!");
: , return "OK";
7 B
e —————— B a“r
I [Line 7 Column 1
Mai n This function will be called by the Script
Runner. Only the code in this main function
gets executed.
| nput s First argument of main function: a list of
input file paths (type: list of strings).
out put Fol der Second argument of the main function:
the folder where AE expects the script’s
result files. AE will continue the flow with
the files you write in this folder. If you leave
this folder empty, AE will continue the flow
with the inputs of the Run Script task (type:
string).
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par ans Third argument of main function: additional
script parameters, injected into the script
via the Run Script ticket. (type: list of
strings)

$.witeln This writes extra log information in the Run
Script task details and log. Without Script
Runner context this call prints text to the
Console, and adds a newline character.

al ert This registers some extra log info in the Run
Script task details and log. Without Script
Runner context this call displays an alert
box.

return “oK’; This will communicate with the Run Script
task that everything went fine. Other
possibilities are Ret urn = “War ni ng”
and Return = “Error”.

2. To test the script locally in the ExtendScript Toolkit, add following code, save and run.

%) * MyHelloWaorld jsx
== | Adabe llustrator CS5.1 2] [main =3 P o E > VY A :
1 function main (inputs, outputFolder, params)
2 B4
3 $.writeln {"Hello, World!");
4 alert ("Another way to say: Hello, World!");
5 return "OK";
6 |}
7
8 // Qur main function is not using any of its arguments, so you can test main without arguments
9 main ();
10 =
&= - ] 4|
|Execution finished. Aesult; OK ne 1 umn 1

Note that the alert box pops up and the ‘Hello, World!” and ‘OK’ result in the Console.

JAVASCRIPT CONSOLE -

Hello, World!
Result: OK
m Another way to say: Hello, World!
Adobe lllustrator C55.1 ok )
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The Script Runner does not attend to the test code in your script. It will execute only the contents
of the main function and ignore the rest. Therefore, you can keep your test code for future local

testing.

3. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a New
Task. Choose the Run Script task, modify its settings and launch the task.

806

New Task - Default

=31 | Launch - Priority: [ Normal 5] [ Hold Ticket: ¢¥~ Tickets: &

Settings for Step: Run Script

Output in: "BROWSE 4]
File Name:

a

Run on: | My Mac Script Runner

S

Script Type: ( ExtendScript

|:]

Application:

Adobe Illustrator

-

Script File:

Script Parameters

MyHelloWorld.jsx

o1

Note that the ‘Hello, World! in the task details and ‘OK’ state are corresponding with

$.witeln("Hello World™)

and Return = “OK” in the script.

(s NeNé] Tasks (RunScriptDemao)
’ = | 23 n ’ RunScriptDemo o ] ’ +h ] Q-
Mode Job MNew Job Search
¥ VIEWS I+ Job Name File Name Task Type Progress Phase | State Launched v| Task ID
) Files '] RunScriptDemo  Blairon.pdf  Run Script  100% 6/4/12 2:11 PM 3788
To Do List
Task Type: Run Script
m e Started on Server: begezingem
4 Products Started at: /412 2:11 PM
inished at: :
I Proofs Finished at 6/4/12 2:11 PM
WebCenter Process Time: 0:00:01
E Plates The script's standard output stream:
= Hello, World!
[£] coi Another way to say: Hello, World!
B Tasks The script's error output stream:
Milestones <none>
I} Tickets
¥ TOOLS = =
9 O
|E| Devices s Llj—l g [:i
— v Relaunch @ Move to History Delete
=P Monis,
1 of 1 selected Server: begezingem User: admin 0
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/.1 Using ExtendScript on Script Runner: A Sample Case.

In the following example we are going to use ExtendScript to Open a file in lllustrator and print it
using a Print Preset.

Note: When you use ExtendScript on Windows, you can avoid troubles while accessing your user
specific settings such as Adobe applications' Presets , Actions etc by stopping the Script Runner
service and running it as an application for the logged in user (who also defined Adobe settings).

Open Start > All Programs > Esko > Automation Engine Script Runner > Preferences .

Stop the Script Runner and uncheck Start at login (which actually means ‘Start as service’) and
Close Preferences.

Start as a console application by double clicking its executable: Script Runner’s program folder>
\bin_ix86\egscrrun.exe (e.g.C:\Esko\bg_prog_fastserverscrrunnt_v120\bin_ix86\egscrrun.exe)

Note: To prevent having to start up the Script Runner every time you log in, add its executable to
your user’s/system’s Startup Iltems.

1. Define a My Print Preset in your Adobe lllustrator application.

2. Open the ExtendScript Toolkit and add following code. This code is aimed to iterate through the
list of inputs. It enables you to handle the inputs one by one, via the i nput variable.

e ¢ M DEFAULT +
%) * Sourcel
(= | ExtenaScript Toolkit CS5.5 4 [man B o BV oA v;
1 function main(inputs, outputFolder, params)
2 B{
3 // Tterate through the list of inputs.
4 for (i=0; i<inputs.length; i++)
5 {
6 var input = inputs[i];
7 // Add code here to handle each input.
8 3
9
10 return "OK";
11 3
12
[ =]

[ ILine 12 Column 1

3. To print every input file using a Print Preset from the script parameters of the Run Script task,
write the code as below. Save this code in the default ExtendScript folder(of Script Runner or
Automation Engine).
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N Toolkit CS5.5 %) [man ] o E OV A :
1 function main{inputs, outputFolder, params)
2 B9
3 // First and only script parameter is the print preset.
4 var printPreset = params[0];
5
6 var returnValue = "OK";
7
8 // Tterate through the list of inputs.
9 for (i=0; i<inputs.length; i++)
10 B {
11 var input = inputs[i];
12
13 try
14 ©
als // Open the input file.
16 wvar myDocument = app.open{File(input), DocumentColorSpace.CMYK);
17 // Create print options and set the print preset.
18 var options = new PrintOptions();
19 options.printPreset = printPreset;
20 // Print the document.
21 myDocument.print{options);
22 // Close the document without saving.
23 myDocument.close(SaveOptions .DONOTSAVECHANGES);
24 H
25 catch (e)
26 © {
27 // Log problem info and et the return value to "Warning".
28 $.writeln{"Problem while printing " + input);
29 $.writeln("Name: " + e.name);
30 $.writeln{"Message: " + e.message);
il returnValue = "Warning";
32 3
33 }
34
35 return returnValue;
36 3}
37 |
& 3 alr
I Jlne 37 Golumn 1

4. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a New
Task. Choose the Run Script task, modify its settings and launch the task.

800 New Task - Default

Ez@ Launch éPrioriw: Normal B: 1 Hold

Ticket: s~ Tickets: g -

Settings for Step: Run Script

Output in: [1
a File Name: ERCEE
Runon: | My Mac Script Runner I+i
Script Type: [ ExtendScript I%i
Application: Adobe Illustrator ﬁ
Script File:  MyPrint.jsx [1 ﬁ

Script Parameters

Launching this ticket will result in the selected lllustrator files being printed using the Print Preset
specified as script parameters (My Pri nt Preset) in the task.
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3. Appendix : Script Samples

Note:

Sample scripts are provided as-is with no warranty of fitness for a particular purpose. These scripts
are solely intended to demonstrate techniques for accomplishing common tasks. Additional script
logic and error-handling may need to be added to achieve the desired results in your specific
environment.

It is up to the user to verify that his intended use of the offered automation functionality is compliant
with any third party license agreement and/or other restrictions applicable to any non-Esko products.

3.1 AppleScript Code Samples

MyHelloWorld.applescript

on mai n(i nputs, out putFol der, parans)
log "Hello, World!"

return "CoK"
end main
on run

-- Qur mai n functionis not using any of its argunents, so provi de enpty ones
set inputs to {} -- enpty list

set outputFolder to "" -- enpty string

set params to {} -- enpty list

mai n(i nputs, output Fol der, parans)

end run

MyDuplicate.applescript

on mai n(i nputs, outputFol der, parans)
set returnValue to "CK"

-- Translate the output folder (UNIX path) into an AppleScript file
ref erence
set out put Fol der Ref erence to POSI X fil e out put Fol der

-- Get the maxi mumsi ze fromthe script paranmeters and convert fromnegabyte
to bytes
set maxSize to (item1 of parans) * 1000000

-- lterate through the list of inputs

repeat with input in inputs

-- Translate the input (UNI X path) into an AppleScript file reference
set inputReference to PGSI X file input

-- Get the size of the input
set inputSize to size of (info for inputReference)

-- Check wether the input is OKto duplicate
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if inputSize < naxSi ze then
-- Duplicate input to output folder
tell application "Finder" to duplicate inputReference to

out put Fol der Ref erence with repl aci ng

el se

log input & " is too big to duplicate"

set returnVal ue to "Wrning"

end if
end repeat

return returnVal ue
end main

3.2 Shell Script Code Sample

MyCopy.sh
#!/ bi n/ bash
# Split up the input file paths into a |ist

# via the Internal Field Separator (IFS)
OLDI FS=$I FS # Al ways keep the original IFS

|FS=":" # Now set it to '
# Split up "$1' into the '"inputs' variable, with ':' as separator
i nputs=( $1 )

| FS=$OLDI FS # Restore the original |IFS
i nput Count =${ #i nput s[ @ }

# Cet the output folder
out put Fol der =$2

# CGet the maxi mum size fromthe script paraneters
# and convert from negabyte to bytes
maxSi ze="expr $3 \* 1000000°

exi t Val ue=0

# Iterate through the Iist of inputs
for (( 1=0; i<${inputCount}; i++ ));

do

i nput =${i nput s[ $i ]}

# Cet the size of the input

input Si ze="Is -1 "$input" | awk '{print $5}'"

# Check wether the input is OK to copy
if [ $inputSize -1t $nexSize ]; then
# Copy input to output folder
cp -f "$input" "$output Fol der"

el se
echo "$input is too big to duplicate"
exi t Val ue=1

fi

done

exit $exit Val ue
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3.3 Windows Script Code Samples

MyHelloWorld.vbs

Function Mai n(inputs, outputFol der, parans)
Wscri pt. Echo "Hel l o, World!"

' Set the function's return val ue.

Main = "OK"
End Function

' Qur main function is not using any of its argunents,
' so provide enpty ones.

Di minputs()

Di m out put Fol der

Di m par ans()

Mai n i nputs, outputFol der, parans

MyCopy.vbs

Function Mai n(inputs, outputFol der, parans)
Di m r et urnVal ue

returnVal ue = " K"

' Cet the maxi num size fromthe script paraneters
and convert from negabyte to bytes.

Di m maxSi ze

maxSi ze = parans(0) * 1000000

' Create the file systemobject that is going to do the copyi ng.
Dmfilesys
Set filesys = CreateCbject("Scripting. FileSystenhject")
W5cri pt. Echo "Fil e system obj ect created"
' Iterate through the list of inputs.
For Each input In inputs
' Turn the input path into a file object.
Di m i nput Ref erence
Set inputReference = filesys. GetFil e(input)
' Check wether the input is OKto copy.
I f inputReference.Size < naxSi ze Then
' Copy input to output folder.
DimoutputFile
out put Fil e = out put Fol der & "\" & fil esys. Get Fil eNane(i nput)
filesys. CopyFile input, outputFile

El se
W5cri pt. Echo input & " is too big to copy"
returnVal ue = "Warni ng"

End |f

Next

Set the function's return val ue.
Mai n = returnVal ue
End Functi on
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3.4 Batch File Code Sample

Automation Engine

MyCopy.bat

@cho off

rem First script argument contains the input file paths

set inputs=%
rem Tri m surroundi ng quotes

for /f "usebackq tokens=*" %@ in (' % nputs%) do set

rem CGet the output folder
set out put Fol der =9%2

rem Get the maxi mum si ze fromthe script paraneters

rem and convert from negabyte to bytes
set /a maxSi ze=%3*1000000

set exitVal ue=0

remlterate through the input file paths which are separated by ';

. | TERATE_I NPUTS

if "% nputs%=="" goto EXIT
for /f "tokens=1 delinms=;" %@ in ("% nputs% ) do cal
for /f "tokens=1* delims=;" %@ in ("% nputs%) do set

got o | TERATE_ I NPUTS

: HANDLE | NPUT

rem CGet the size of the input
for W@ in (%) do set inputSize=%%62z?
rem Check wether the input is OK to copy
if % nput Size% | ss %mxSi ze% (

rem Copy input to output folder

copy /'y %4 %out put Fol der %
) else (

echo % is too big to copy

set exitVal ue=1

)

got o : eof

EXIT
exit %exitVal ue%

3.5 ExtendScript Code Samples

i nput s=%%-a

: HANDLE | NPUT " 9%8/@"
i nput s=%b

MyHelloWorld.jsx

function main (inputs, outputFol der, paranms) {

$.witeln ("Hello, World!'");

alert ("Another way to say: Hello, World!");

return "OK";
[/ Qur main function is not using any of

mai n wi t hout argunents
main ();
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MyPrint.jsx

function mai n(i nputs, outputFol der, parans) {
[l First and only script paraneter is the print preset.
var printPreset = parans[0];

n G(" ;

var returnVal ue

/1l lterate through the |ist of inputs.
for (i=0; i<inputs.length; i++)

var input = inputs[i];
try

/1 Open the input file.
var myDocunent = app.open(File(input), Documnent Col or Space. CWK) ;
[/l Create print options and set the print preset.
var options = new PrintOptions();
options. printPreset = printPreset;
[/ Print the document.
nmyDocument . pri nt (opti ons);
/1 C ose the docunent without saving.
nmyDocunent . cl ose( SaveOpt i ons. DONOTSAVECHANGES) ;

catch (e)

/1 Log probleminfo and set the return value to "Warning".
$.witeln("Problemwhile printing " + input);

$.witeln("Nane: " + e.nane);
$.witeln("Mssage: " + e.nessage);
returnVal ue = "Warni ng";

}

return returnVal ue;
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